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Note	that	while	it’s	OK	to	change	the	model	resolution	for	the	modelled	head,	it’s	better	to	decide	which	resolution	you	need	before	you	start	shaping	it.	To	do	this	you	need	to	open	the	sidebar,	find	FaceBuilder	in	it,	and	click	Create	a	new	head	button	placed	on	the	main	FaceBuilder	panel.Initialising	FaceBuilder	for	Blender	with	a	new	headLoading
photosOnce	you’ve	initialised	the	model,	you	can	load	the	photographs	of	the	person.	So	every	picture	loaded	into	FaceBuilder	in	the	scene	has	its	own	camera.Camera	settings	&	EXIFFaceBuilder	can	automatically	set	up	the	focal	length	for	each	photo.	Hit	“enter”	after	supplying	the	model	number	and	you’ll	navigate	to	options	for	product	support,
which	include	accessing	and	downloading	your	user	manual	in	PDF	format.Contacting	SharpIf	you	need	to	speak	with	a	person	on	the	Sharp	team,	you	can	reach	out	by	phone	every	day	of	the	week.	Usually,	the	best	values	are	between	10	and	20.The	Expand	edges	setting	helps	you	with	expanding	texture	edges	using	the	colour	of	the	edging	pixel.
Our	Legacy	UV	has	even	less	distortions	but	there	are	many	seams.	You’ll	find	many	different	countertop	microwave	ovens,	as	well	as	built-in	models.	It’s	an	imaginary	entity	made	of	a	3D	camera	and	a	picture	you’ve	loaded.	In	this	case	you	can	use	only	Wavefront	and	Alembic	formats,	because	Blender	modifies	geometry	with	other	formats	and
there’s	no	way	to	prevent	it	at	the	moment.Using	Wavefront	(.obj)	and	Collada	(.dae)	formats	you	can	export	the	texture	along	with	the	model.	A	couple	of	new	buttons	will	appear	on	the	Views	panel,	in	the	viewport	you’ll	see	the	photo	you	loaded	and	the	mesh	of	the	FaceBuilder	3D	model.	All	settings	in	the	export	window	will	be	already	configured
for	importing	into	Unreal	Engine	or	Unity	game	engines.LinksDownload	FaceBuilder	for	Blender	from	our	site.Watch	the	detailed	FaceBuilder	livestream.Follow	us:	Facebook,	Twitter,	Instagram,	YouTube	Then	a	couple	of	neural	networks	will	find	a	face	on	the	photo	and	set	up	all	required	pins	to	match	the	position	and	the	shape.	There	are	two	ways
of	doing	that:	online	and	offline.	Deleting	may	be	useful	when	you	want	to	transfer	the	project	file	without	the	texture	(which	changes	the	file	size	from	kilobytes	to	megabytes).Texture	generationIn	the	Advanced	section	of	the	Texture	panel	you	can	tweak	the	texture	grabbing	algorithm.	We’ve	all	been	there—you	moved	to	a	new	home	or	apartment,
and	it’s	time	to	set	up	electronics	and	components.	The	HTML	version	for	offline	use	can	be	downloaded	on	the	front	page	of	the	reference	manual.	Reset	value	resets	the	values	of	shape	keys	to	0	in	the	current	frame,	note	that	it	doesn’t	alter	the	animation	and	it	doesn’t	create	a	keyframe	—	you	need	to	do	it	manually	if	you	want	to	save	this	state	in
the	current	frame.You	can	always	animate	blendshapes	manually	setting	up	their	values	for	every	keyframe.	Just	keep	in	mind	that	Blender	uses	relative	file	paths	in	projects,	so	storing	files	on	different	hard	drives	wouldn’t	be	a	future-proof	idea.FaceBuilder	doesn’t	include	the	photographs	into	project	files,	so	when	you	want	to	transfer	the	project
to	another	computer	(or	a	person),	you	need	to	transfer	not	only	the	project	file,	but	the	photographs	as	well	if	you	or	the	person	you	transfer	the	project	to	are	going	to	change	the	shape	of	the	head	using	the	photos.At	the	same	time,	the	created	texture	is	stored	inside	the	project	file,	so	first	you’re	transferring	it	along	with	the	project	file	and
second,	it	makes	your	project	file	quite	heavy.	You’ll	also	find	a	third	section	with	state-of-the-art	TVs	manufactured	by	Sharp.	They	may	help	when	you	have	differently	lit	or	coloured	parts	of	the	face	on	different	photographs	and	therefore	you	get	shadow	and	colour	patches	on	texture.	The	aligning	results	are	not	always	100%	accurate	at	the
moment,	so	you’d	likely	need	to	adjust	the	position	creating	new	pins	or	moving	the	already	created	ones	in	most	cases.You	create	pins	by	clicking	anywhere	on	the	mesh	—	the	red	square	dots	that	appear	over	it	are	what	we	call	“pins”.	The	instructions	for	building	the	manual	yourself	can	be	found	in	the	Contribute	chapter.	Unfortunately	the	.pdf
building	for	the	Blender	manual	with	Sphinx	and	LaTeX	is	currently	a	bit	fragile.	But	we	really	recommend	starting	with	automatic	alignment	since	it	reduces	pinning	time	dramatically!For	manual	pinning,	we	recommend	starting	with	a	3/4	view,	because	it	gives	you	more	information	about	the	head:	the	front	and	the	side	views	at	the	same	time.
Steam	ovens,	convection	ovens	and	induction	cook	tops	are	also	available	from	Sharp.	You	need	to	open	the	Camera	panel,	and	enter	the	value	in	the	Focal	Length	field.PinningWhen	you’ve	loaded	photos,	it’s	time	to	decide	if	you	plan	to	use	facial	expressions.	If	you	choose	the	Wavefront	format,	the	texture	files	(.mtl	and	.png)	will	be	saved	next	to
the	model	file,	while	the	Collada	file	will	have	everything	embedded	with	the	model.For	exporting	a	geometry	with	all	blendshapes	and	animation,	use	the	Export	as	FBXbutton	on	the	Blendshapes	panel.	At	the	top	of	the	home	page,	hover	your	cursor	over	“Appliances”	or	“Business	Products”	and	peruse	the	pop-up	menu	that	appears.	If	there	is	more
than	one	face	on	the	photo,	the	add-on	will	let	you	choose	which	face	you	want	to	pin.	Every	time	you	change	the	topology,	you’re	losing	preciseness,	by	an	unnoticeable	amount	but	still.Next,	we	have	the	Pins	and	Wireframe	panels	where	you	can	tweak	the	appearance	of	pins	and	the	wireframe	in	the	Pin	mode.The	Texture	panel	gives	you	access	to
the	experimental	feature	of	automatic	texture	generation.And	finally,	theBlendshapes	panel	has	controls	for	the	FACS	blendshape	functionality.	All	you	have	to	do	is	enter	the	product	information	you’re	looking	for	and	hit	enter.	That	means	you	can	load	multiple	files	into	the	sequence	continuously.Live	Link	Face	(a	recorded	video	and	final
animation)The	format	of	the	file	is	pretty	simple,	so	you	can	compose	it	yourself	with	your	custom	software	solutions.	Then,	you	should	be	able	to	find	the	user	manuals	for	free.Search	Help	ForumsWhen	individuals	need	help	troubleshooting	or	setting	up	products,	they’ll	go	to	forums	for	help.	Spherical	is	a	slightly	modified	popular	‘cylindrical’	UV
with	better	handling	of	the	top	part.12	UV	maps	in	FaceBuilder	—	4	UVs	and	3	topology	resolutionsAfter	pressing	the	Create	Texture	button	you	can	choose	the	views	you	want	to	use	for	texture	grabbing	(the	views	that	don’t	have	a	pinned	model	will	be	ignored	automatically),	pressing	OK	in	the	dialog	window	starts	the	process	of	grabbing	and
stitching	the	texture,	which	usually	takes	a	lot	of	processing	power	and	also	takes	some	time,	so	you	need	to	be	a	little	bit	patient.Once	the	process	is	finished	you	can	see	the	texture	is	applied	to	the	object	if	you	left	the	corresponding	checkbox	checked,	if	you	didn’t	—	you’ll	only	see	a	message	in	Blender’s	status	bar	telling	you	that	the	texture	was
created	—	then	you	can	apply	the	material	automatically	created	with	for	the	texture	using	the	Apply	texture	button.You	can	also	export	and	delete	the	texture	using	the	buttons	on	this	panel.	Then,	a	list	of	search	results	appear	similarly	to	a	traditional	search	engine.Use	a	Traditional	Search	EngineIf	you’re	having	difficulty	with	manufacturer
websites,	help	forums	or	databases,	you	can	opt	for	searching	the	Internet	the	traditional	way.	For	the	second	option,	press	the	Align	Face	button	on	the	Views	panel.	Don’t	forget	you	can	undo	and	redo	most	actions,	but	for	pinning	you	often	need	to	do	it	twice	to	take	the	effect	—	unfortunately,	that’s	how	Blender	works.If	you	prefer	manual	pinning,
you	can	do	that	just	as	before.	The	shape	key	editor	in	the	Animate	panel	gives	you	control	over	keyframes.Using	shape	keys	panelYou	can	also	import	pre-recorded	facial	animation	using	the	Load	CSV	button	on	the	Blendshapes	panel.	FaceBuilder	has	4	different	UV	maps:	Butterfly,	Legacy,	Maxface,	and	Spherical.	Currently,	only	the	format	of	Live
Link	Face	app	is	supported.	Be	careful	that	you’re	visiting	trusted	websites,	so	you’re	not	downloading	a	virus	inadvertently.Check	Out	Do-it-Yourself	WebsitesWhen	do-it-yourself	websites	are	explaining	how	to	build	or	troubleshoot	something,	they’ll	often	post	instructions	or	links	to	PDFs	for	free	product	manuals.	Our	add-on	will	install	the
downloaded	core	library	file	and	tell	you	that	you	can	use	the	add-on	now.	The	third	one	is	Autofill	that	tries	to	intellectually	fill	gaps.	In	the	right	upper	corner	of	this	window	you’ll	see	the	Install…	button.	When	you	have	pinned	four	or	five	views	(e.g.	two	of	3/4,	the	frontal	and	two	side	views),	you	can	return	to	the	views	you	pinned	earlier	and	refine
the	model	position	and	shape	on	them	creating	new	pins	when	necessary.	At	the	very	least,	these	websites	may	lead	you	toward	the	user	manuals	you	couldn’t	find	previously.	MORE	FROM	QUESTIONSANSWERED.NET	Last	update:	ver.	Many	manufacturers	will	post	the	user	manuals	for	their	products	online	in	a	searchable	database	so	consumers
can	download	them	in	.pdf	form.	Click	it	and	choose	the	downloaded	.ZIP	file	—	the	add-on	will	be	installed.FaceBuilder	for	Blender	add-on	installationThe	process	is	a	bit	different	for	Mac	users.	Having	less	also	works	with	the	obvious	outcomes	of	losing	the	details	that	you	cannot	see.A	couple	of	notes	on	taking	photos.	2021.2FaceBuilder​	is	an	add-
on	for	Blender	for	3D-modelling	of	human	faces	and	heads	based	on	photos.	make	pdf	is	the	command	to	create	the	.pdf	version.	Weekday	hours	stretch	from	early	morning	into	the	evenings.	Weekend	hours	begin	mid-morning	and	continue	into	the	evenings.	Now	you	can	start	pinning	the	mesh	to	the	photo.It	can	be	done	manually	or	using	automatic
face	alignment.	Delete	removes	the	shape	keys	and	unlinks	the	animation.	You	can	use	any	type	of	photos,	including	ones	with	non-neutral	facial	expressions.	When	you	press	the	download	button	on	our	website,	you	get	a	.DMG	file	which	you	need	to	mount	—	double	click	in	Finder	or	open	from	the	web-browser	downloads	list,	Safari	often	mounts
DMG	files	automatically.	So,	if	you’re	unable	to	find	a	Magic	Chef	user	manual	on	the	product	manufacturer’s	website,	for	example,	you	may	be	able	to	find	something	in	a	help	forum.Use	a	Website	DatabaseMany	website	databases	are	available	containing	free	product	user	manuals	online.	Creating	text	objects	in	Blender	is	possible	through	Add	>
Text.	And	if	you	need	your	appliances	serviced,	you	can	search	for	an	authorized	service	center	near	you.	If	there’s	no	EXIF	data,	the	focal	length	estimation	will	be	turned	on	and	used	in	a	smart	way	taking	into	account	the	dimensions	of	every	photo.	But	for	automatic	alignment,	it’s	usually	better	to	start	with	the	frontal	view.Pinning	a	model	in	Pin
ModeThe	first	three	pins	change	the	position	and	scale	of	the	mesh,	with	four	pins	you	can	change	the	shape	and	expression.	The	majority	of	these	searchable	product	databases	act	like	a	traditional	search	engine	and	don’t	require	a	user	registration	or	login.	You	can	also	export	it	using	the	Export	button	and	then	delete	it	from	the	project.To	export
the	geometry	you	need	to	select	it	in	the	3D	viewport	and	then	go	to	the	File	>	Export	menu	where	you	can	choose	the	file	type	and	save	the	model.	You	can	choose	a	specific	product,	FAQs,	purchase	options	and	more.After	purchasing	a	Sharp	product,	be	sure	to	visit	the	Sharp	website	to	register	it.	With	FaceBuilder	you	don’t	need	to	be	an
experienced	3D	modeler	to	create	a	quality	3D	model	with	clean	topology.	The	Sharp	Home	Electronics	Company	of	America	is	the	division	in	charge	of	manufacturing,	marketing	and	servicing	home	appliances	such	as	microwaves.Sharp	ProductsSharp	appliances	are	part	of	a	well-equipped	kitchen.	At	0	every	pixel	will	have	an	average	colour
between	colours	taken	from	all	pinned	views	where	that	pixel	is	visible.	Both	are	accessible	on	the	preferences	pane	of	our	add-on	(Edit	>	Preferences	>	Add-ons	>	KeenTools	FaceBuilder).If	the	machine	where	you	want	to	install	our	add-on	is	connected	to	the	Internet,	then	you	can	try	automatic	online	installation	—	just	press	the	Install	online
button	and	our	add-on	will	download	the	core	library	file,	install	it	to	the	add-on	directory	and	tell	you	that	now	you	can	use	the	add-on.KeenTools	Core	automatic	online	installationYou	can	also	download	the	core	library	manually	from	our	website	and	specify	the	path	to	the	downloaded	file	using	the	Install	from	disk	button.	Press	the	Create	button	on
the	Blendshapes	panel	to	generate	shape	keys.	The	most	important	settings	are	the	Angle	strictness	and	the	Expand	edges.The	first	one,	Angle	strictness,	determines	how	the	angle	of	view	affects	the	pixel	colour	when	it’s	grabbed.	But	we	made	it	possible	to	import	pre-recorded	animation	as	a	CSV	file	of	Live	Link	Face	format.To	control	blendshapes
manually,	use	the	Shape	keys	tab	on	the	Object	Data	Properties	panel.	The	download	link	is	on	the	front	page	of	the	manual.	But	you’re	free	to	try	and	choose	any	other	format	depending	on	your	workflow,	there	are	plenty	of	them,	including	the	ones	people	often	use	for	3D	printing.If	you’re	going	to	use	the	head	for	facial	tracking	with	our
FaceTracker,	you	need	to	keep	the	topology	intact,	we	rely	on	vertex	order	in	FaceTracker,	so	please	don’t	use	any	kind	of	automatic	optimisations	during	exporting.	Also,	it’s	better	to	use	manual	White	Balance	in	a	camera,	otherwise,	colours	will	likely	differ.TexturingThe	texture	extraction	algorithm	built-in	into	FaceBuilder	for	Blender	is	still	in	its
early	experimental	stage.	You’ll	need	to	look	at	the	product,	determine	its	serial	number	or	other	identifying	marks	to	perform	the	search.	But	usually	asking	a	person	to	sit	or	stand	relaxed	and	still	for	15–30	seconds	while	you	take	all	the	required	photos	is	more	than	enough.	You’ll	see	more	buttons	to	control	your	blendshapes.	The	possible	values
are	0–100.	You	can	either	bring	them	to	the	screen	by	pressing	the	N	key,	or	by	clicking	the	tiny	little	triangle	in	the	right	upper	corner	of	the	viewport.Opening	FaceBuilder	panel	in	BlenderFaceBuilder	has	eight	panels.	The	main	thing	I	want	is	type	fonts	and	I	could	not	find	any	in	the	program.	We	don’t	recommend	having	more	than	one
FaceBuilder	object	in	a	scene	because	it	can	lead	to	confusion.Using	seven	additional	panels	you	can	control	the	chosen	FaceBuilder	object	in	various	ways.The	Camera	panel	lets	you	modify	the	camera	settings.On	the	Views	panel	you	can	load,	remove	and	replace	photographs,	switch	to	Pin	mode	for	different	photographs,	turn	on	facial	expressions
(more	on	them	later).	If	the	photographed	person	doesn’t	appear	to	have	the	neutral	facial	expression	even	on	one	of	the	photos,	you	need	to	turn	on	facial	expressions	support.When	photos	are	loaded,	it’s	time	for	what	we	call	“Pinning”:	click	one	of	the	buttons	with	an	image	file	name	(a	View)	on	the	Views	panel	—	you	will	switch	the	Pin	mode	on.
Fortunately,	these	guidelines	will	help	you	find	free	product	user	manuals	online.Visit	the	Product	Manufacturer’s	WebsiteDepending	on	the	age	of	the	product	is	you’re	using,	chances	are	you’ll	be	able	to	find	the	user	manual	for	it	online.	When	the	zip	file	is	stored	locally,	you	need	to	open	the	Preferences	window	in	Blender	and	go	to	the	Add-ons
section	(Edit	>	Preferences	>	Add-ons).	Please	keep	in	mind	that	versions	of	the	add-on	and	the	core	library	should	be	the	same.KeenTools	Core	manual	(offline)	installationFirst	stepsYou	control	FaceBuilder	in	Blender	using	panels	in	the	right	sidebar	of	the	3D	viewport.	We	recommend	using	Wavefront	(.obj)	or	Alembic	(.abc)	formats,	because	other
ones	do	not	work	consistently	in	Blender.	In	this	case,	all	red	dots	will	disappear,	the	mesh	on	this	view	will	be	reset	to	the	default	shape	but	its	position	will	remain	the	same.Pinned	ViewsUsually,	you	need	up	to	seven	views:	the	frontal	one,	two	of	¾	ones,	two	side	views,	one	half-bottom	view,	and	one	half-top	view,	but	you’re	free	to	add	more	if	you
feel	that	you	need	them.	On	the	main	top	panel,	you	can	create,	delete	and	select	FaceBuilder	objects.	Repeat	this	action	on	every	photo	you	loaded.	Still,	if	you	need	to	set	up	the	focal	length	manually,	we	keep	the	manual	control	option.Setting	up	the	CameraTo	set	up	the	camera	manually	you	need	to	know	the	35mm	equivalent	focal	length	used	for
each	photo.	But	it’s	important	to	understand	that	if	you	use	non-neutral	facial	expressions	and	focal	length	estimation,	the	FaceBuilder	algorithms	get	too	many	“degrees	of	freedom”	for	their	guesswork,	so	not	only	the	computation	becomes	slower,	but	also	the	preciseness	of	the	model	suffers.	If	the	facial	expression	is	not	neutral	—	turn	on	the	Allow
facial	expressions	checkbox	before	pressing	the	Align	Face	button	—	then	the	expression	will	be	matched	as	well.	Although	sometimes	these	functions	work	well,	it’s	still	much	better	to	have	a	uniformly	lit	face	while	shooting	the	face	from	many	angles	of	view	if	you	plan	to	use	the	photos	for	texture	grabbing.BlendshapesWhen	the	head	model	is
ready,	you	can	animate	it	with	51	built-in	FACS-blendshapes.	As	part	of	Sharp	Electronics	Corporation,	Sharp	Imaging	and	Information	Company	of	America	takes	care	of	the	business	products	you	find	in	offices.	It’s	possible	to	load	multiple	image	files	at	once.Loading	picture	files	into	viewsThe	distance	to	the	person	on	the	photos	is	not	important,
but	it’s	advisable	to	have	them	taking	the	most	space	of	the	frame	and	at	the	same	time	to	keep	distortions	to	a	minimum	(e.g.	don’t	use	wide-angle	lenses	close	to	the	subject).	Then	you	can	pin	more	views	and	repeat	the	refinement	process	until	you’re	satisfied	with	the	quality	of	the	model.If	the	model	feels	too	stiff,	use	theShape	rigidity	and	the
Expression	rigidity	settings	(Model	panel)	for	changing	how	much	pins	affect	the	shape	and	the	expression	of	the	model.You	can	delete	all	pins	by	pressing	the	Remove	all	pins	button	on	the	Views	panel	at	any	time.	So,	if	you’re	trying	to	figure	out	how	to	fix	your	refrigerator	or	dishwasher,	visiting	a	do-it-yourself	website	may	hold	the	key	to	the
answers	you’re	looking	for	regarding	this	information.	You	may	have	to	install	additional	software	to	open	ePUB	files	though,	for	instance	Adobe	Digital	Editions	or	Sumatra	PDF.	And	when	you	need	air	purification,	Sharp	has	a	number	of	air	purifiers	available.Sharp	printers	and	copiers	are	a	solid	choice	for	places	of	business	as	well	as	home	offices.
If	you	need	to	remove	a	pin	—	right-click	does	it.	Maxface	gives	you	as	much	resolution	for	the	face	as	possible.	VIEW	WIKI	Update:	Since	Blender	2.92	the	manual	is	also	available	as	ePUB,	which	means	that	building	it	yourself	is	no	longer	necessary.	That’s	why	if	you’re	after	quality,	you	need	to	shoot	the	person	knowing	the	camera	settings	and
taking	care	of	the	person’s	appearance.In	an	ideal	case,	you	can	set	up	a	number	of	cameras	around	a	person,	like	if	you’re	setting	up	a	photogrammetry	rig,	and	then	take	all	photos	in	one	moment.	At	100	only	the	views	where	‘we’re	looking’	at	this	pixel	at	90°	will	be	used,	so	the	colour	becomes	more	accurate,	but	you’re	losing	the	information	for	a
lot	of	pixels	at	which	you	don’t	have	the	90°	view.	Here	as	well	you	can	import	a	CSV-file	with	pre-recorded	animation,	and	also	export	the	animated	model.Model	initialisationBefore	you	create	your	first	FaceBuilder	head	it’s	better	to	remove	all	unneeded	objects	from	the	scene,	especially	the	ones	placed	in	the	center	of	the	scene,	because	a	newly
created	head	will	be	placed	in	the	center	as	well	and	then	you	can	run	into	situation	when	the	objects	will	be	interfering	with	each	other.	Sharp	provides	extensive	user	support	to	ensure	that	you	know	how	to	use	the	products	you	purchase.The	Sharp	CompanyThe	Sharp	Electronics	Corporation	is	a	subsidiary	of	the	Sharp	Corporation	based	in	Osaka.
The	app	works	only	on	iOS	devices	equipped	with	the	TrueDeph	camera,	like	iPhone	X	and	newer	models.Note	that	the	animation	is	being	loaded	from	the	current	keyframe.	Using	it	may	help	with	hiding	seams	on	the	applied	texture.Then	we	also	have	two	super-experimental	functions:	Equalize	brightness	—	which	tries	to	level	the	brightness	of	a
pixel	on	different	views,	and	Equalize	color	—	which	levels	the	colour	of	pixels.	Usually,	it’s	enough	to	walk	outside	to	a	wide-open	space	with	no	direct	sunlight,	overcast	weather	works	best	in	such	cases.	You	can	do	this	on	the	Views	panel	by	clicking	the	Add	images	button.	Also	worth	knowing	that	if	you	ask	a	person	to	change	the	position	of	their
head	—	the	shape	of	their	head	close	to	the	neck	is	going	to	be	kind	of	distorted	by	tensed	muscles,	so	instead	it’s	better	to	walk	around	with	a	camera	while	the	person	is	totally	still.	You	start	with	getting	a	few	photos	of	a	person	from	different	angles	of	view	and	then	place	a	model	on	each	of	them	to	build	a	head	or	a	face	model.	The	3D	models	can
be	later	used	for	sculpting,	animation,	tracking	or	anything	else	in	Blender	or	exported	into	a	file	and	imported	into	any	other	3D	software.InstallationThe	complete	installation	process	is	covered	in	this	video.It	all	starts	with	downloading	a	.ZIP	file	with	the	add-on	from	our	website.	If	you’re	not	sure	where	the	model	number	is	located,	click	the	link
to	get	hints	for	finding	it.	It’s	made	this	way	because	many	Mac	users	were	having	the	ZIP	file	unpacked	automatically	after	downloading.The	next	step	would	be	to	find	“KeenTools	FaceBuilder”	in	the	list	of	add-ons	(in	the	Mesh	category)	and	turn	it	on	using	a	checkbox	in	the	left	upper	corner.Core	libraryUnfortunately,	we	cannot	ship	our	core
library	within	the	add-on	package	due	to	Blender	license	restrictions,	but	we	made	it	as	easy	as	possible	to	install	it	independently.	MORE	FROM	QUESTIONSANSWERED.NET	Documentation	about	internal	architecture	(Blendfile	format,	dependency	graph,	etc.),	compiling	Blender,	and	other	technical	topics.	And	the	last	thing	to	keep	in	mind	is	that
if	you’re	planning	to	grab	a	texture	from	the	photos	—	you	need	to	set	up	proper	uniform	lighting,	otherwise	the	texture	brightness	and	colours	will	be	different	in	different	areas.	We	recommend	starting	with	corners	of	eyes,	mouth,	ears,	nose,	chin	and	then	switching	to	another	view	to	repeat	the	same	“draft”	pinning.	Using	this	method	will	reveal
where	other	discussion	forums,	blogs	and	websites	are	posting	product	user	manuals	online	for	free.	If	you	don’t	want	or	don’t	need	to	transfer	the	texture,	you	can	delete	it	using	the	Delete	button	on	the	Texture	panel.	Choose	from	many	different	multi-function	copiers	and	printers	that	perform	all	of	the	essential	functions	you	need	to	manage	your
business.Navigating	the	Sharp	WebsiteThe	Sharp	USA	website	is	divided	into	appliances	for	the	home	and	machines	for	the	office.	Registration	ensures	that	you’ll	have	all	the	benefits	of	a	product	warranty,	and	you	can	get	product	support	if	you	need	it.Sharp	User	ManualsOn	the	Sharp	USA	home	page,	scroll	to	the	bottom	of	the	page	and	click
“Support	Center.”	Find	the	section	where	you	can	enter	your	product	model	number,	and	enter	it	into	the	open	field.	Except,	when	you	bought	them,	you	didn’t	think	you’d	need	the	user	manuals	after	initially	setting	them	up.	Here	as	well	you	will	find	most	buttons	you	need	in	Pin	mode	once	you	switch	to	this	mode.FaceBuilder	panels	in	BlenderThe
Model	panel	gives	you	control	over	parameters	of	the	3D	model,	such	as	responsiveness	to	pins	for	shape	and	expressions	(Rigidity),	the	visibility	of	various	face	parts	(nose,	ears,	neck,	etc),	geometry	scale	and	resolution	(high,	middle,	or	low-poly).	You	can	also	export	facial	animation	in	form	of	a	CSV	file	with	ARKit-compatible	FACS	blendshape
coefficients	from	our	FaceTracker	node	for	Nuke.Project	management,	Saving	&	ExportingYou	can	easily	save	the	project	in	the	middle	of	the	face-building	process,	then	load	it	and	continue	the	work	from	the	point	where	you	left	it.We	recommend	keeping	the	project	file	in	the	same	folder	where	you	keep	the	photos	used	in	it	or	keeping	photos	in	the
directory	which	is	placed	next	to	the	project	file.	Although	sometimes	these	functions	work	well,	it’s	still	much	better	to	have	an	uniformly	lit	face	while	shooting	if	you	plan	to	use	the	photos	for	texture	grabbing.Then	we	also	have	three	super-experimental	functions:	Equalize	brightness	—	which	tries	to	level	the	brightness	of	different	views,	and
Equalize	color	—	which	levels	the	colour	of	pixels.	For	example,	by	default	Blender	starts	with	a	Cube,	a	Camera	and	a	Light	in	the	scene,	you	can	either	select	them	using	your	mouse	and	then	delete	them	from	the	context	menu	(right	mouse	button),	or	you	can	just	use	the	shortcut	sequence:	A	→	X	→	D	(select	everything	→	delete	→	confirm).You
start	working	with	FaceBuilder	creating	a	head	3D	object	if	it’s	not	already	created.	We	decided	to	include	it	to	give	you	a	simple	approach	of	getting	something	good	enough	to	start	from.It	works	using	the	views	where	you’ve	pinned	the	model:	projecting	each	pixel	of	the	UV	map	to	the	photo	according	to	the	model	position.Before	launching	the
texture	creating	process,	you	can	set	up	the	texture	resolution	and	the	desired	UV	map	on	the	top	of	the	Texture	panel.	You	don’t	need	to	create	many	of	them	at	once,	instead	create	them	one	by	one	for	distinguishable	parts	of	the	head	(or	face)	and	then	drag	them	to	the	corresponding	positions	on	the	photo.	Butterfly	is	aimed	at	reducing	distortions
with	as	few	seams	as	possible.	With	Sharp	products	in	your	home	or	office,	you	have	the	assurance	of	quality	and	innovation.	Sharp	also	provides	live	chat	support	on	the	website	during	the	same	hours	as	phone	support	is	available.	If	there’s	EXIF	data,	it’ll	be	used	and	then	you	get	very	precise	results.	The	generation	of	the	table	of	contents	doesn't
work	properly	and	there	may	be	formatting	issues.	Many	of	the	technicians	or	other	users	who	work	with	these	individuals	will	post	free	product	manuals	to	help	consumers	resolve	their	issues.	The	value	determines	the	expansion	in	percentages	of	the	output	format	height.	The	font	can	be	selected	in	the	Object	Data	properties	of	the	text	object.	Also,
it’s	important	to	know	that	FaceBuilder	expects	that	the	pictures	have	no	lens	distortion	at	all,	so	while	it’s	not	a	deal-breaker,	still	you’ll	get	much	better	results	if	you	undistort	photos	before	using	them	with	FaceBuilder	(lens	distortion	in	Blender).Whenever	you	load	a	new	photo,	the	View	is	being	created.	The	FaceBuilder	head	will	be	animated
with	the	blendshape	coefficients	found	in	the	CSV	file.	The	ZIP	file	which	you	need	for	further	installation	is	inside	the	mounted	volume.
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